In Chapter 7, I described how you can edit the data in your MIDI tracks graphically by using the Piano Roll view. SONAR also provides tools so you can edit your MIDI data as standard music notation and guitar tablature. As a matter of fact, you can compose new music while working with notation by graphically adding, editing, and deleting notes. You can also add many of the symbols used in music notation, such as chord symbols, expression markings, and lyrics. When you’re ready, you can print your music as sheet music, complete with title, copyright notice, page numbers, and more by using the printer attached to your computer. To give you an idea of how to use all these wonderful features, this chapter will do the following:

- Show you how to use the Staff view.
- Explain how to edit music as notes and tablature.
- Demonstrate applying musical symbols.
- Teach you how to handle percussion.
- Show you how to use the Lyrics view.
- Explain how to print your music.

The Staff View
SONAR provides three different tools for editing MIDI data: the Event view, the Piano Roll view, and the Staff view. For really precise numerical editing, the Event view can’t be beat. For precise graphical editing of both MIDI note and controller data, the Piano Roll view is the tool you’ll want to use. Many musicians, however, are used to composing and editing in standard music notation. The Staff view comes into play at this point.

Using the Staff view (see Figure 15.1), you can add, edit, and delete MIDI note data within your MIDI tracks. The Staff view looks similar to sheet music on a piece of paper and represents notes as standard music notation and guitar tablature on musical staves with clefs, key signatures, time signatures, and many of the other symbols you might expect to see on a sheet of music.

More precisely, the Staff view consists of three major sections: the Staff pane (located in the center of the view, displaying the notes in the currently selected tracks), the Track pane (located
Figure 15.1 Working in the Staff view is just like composing music on paper, but a lot easier.
at the right of the view, listing the tracks currently shown in the view), and the Fretboard pane (located at the bottom of the view, displaying the notes currently being played as they would appear on a six-string guitar neck that uses standard tuning). There is also a toolbar you can use to access the various functions provided by the Staff view, but I'll be referencing the equivalent keyboard shortcuts instead. If you would like to use the toolbar, simply hover your mouse over the buttons to see the functions they represent.

You'll also notice that the Staff view has scroll bars. They work just as they do in the other views. In addition, this view has a Snap To Grid function, which you can access by pressing the N key. Other similarities are the Marker area and the Time Ruler, which are located just above the Staff pane.

You can open the Staff view in two different ways.

- In the Track view, select the MIDI track(s) you want to edit and then choose Views > Staff (or press Alt+7).
- In the Track view, right-click a track or clip and choose View > Staff.

**Open the Staff View with a Double-Click** By default, double-clicking a MIDI clip opens the Piano Roll view. But you can change that by right-clicking anywhere inside the Clips pane of the Track view and choosing View Options from the menu. In the Clip View Options dialog box, choose a new option from the MIDI Clips menu and click OK. If you choose Staff View from the menu, the Staff view will open any time you double-click a MIDI clip.

Whichever method you choose, SONAR will open the Staff view and display the data from the track(s) you selected.

**Changing the Layout**

If you select more than one track to be displayed, the Staff view will show the data from each track on a separate stave.

**Pick Tracks** Just like the other views, the Staff view provides a Pick Tracks feature, which you can access by pressing the T key. You can use Pick Tracks to change the tracks that are displayed.

SONAR picks the clef (treble or bass) for each stave automatically by looking at the range of notes contained in the data. If a track has notes that fall into both clefs, it shows the data on two connected staves, one with a treble clef and one with a bass clef.
Up to 24 Staves  You can display up to 24 staves of notation in the Staff view at once. This does not necessarily mean you can display 24 tracks, though. If the data from each track is shown on a single stave, then you can display 24 tracks at once. If, however, the data from each track is shown on a pair of staves (as previously mentioned), you can display only 12 tracks at once. Of course, you can show some tracks with one stave and some with two, so the number of tracks will vary.

If you want, you can override these automatic stave settings by adjusting the Staff View Layout parameters. To adjust the way the data from your MIDI tracks is displayed in the Staff view, just follow these steps:

1. Right-click anywhere in the Staff pane and choose Layout to open the Staff View Layout dialog box (see Figure 15.2).

2. From the Track list, select the name of the track that you want to change.

3. In the Staff Properties section, set the Clef parameter to the type of clef you want to use for that track. If you choose the Treble/Bass option, the track will be displayed on two staves. To determine the notes that will be shown on each stave, enter a note value for the Split parameter. Notes that are equal to or higher than the pitch you enter are shown on the lower stave. For notes that are lower than the split pitch, the notes will be shown on the upper stave.

Figure 15.2  You can use the Staff View Layout dialog box to change the way your data is displayed in the Staff view.
shown on the treble clef staff, and notes that are lower than the pitch you enter are shown on the bass clef staff.

4. Click Close.

The track will be shown with the stave settings you specified.

**Percussion Tracks**

If you open in the Staff view a MIDI track that has its Channel parameter set to 10, and you had previously set up your sound card ports to use the General MIDI instrument definitions (which you learned about in Chapter 3), the Staff view will display that track automatically as percussion notation in a percussion staff. It displays the track this way because when you’re using General MIDI, it is standard practice to put all percussion instruments on MIDI channel 10. If you want to override this automatic setting, you can do so as explained previously.

You can also change a number of other settings to customize the way your percussion staves appear. If you select your percussion track in the Staff View Layout dialog box, a new button (called **Percussion Settings**) will become active. If you click this button, the Percussion Notation Key dialog box will appear (see Figure 15.3).

![Percussion Notation Key -- 1](image)

**Figure 15.3** You can use the Percussion Notation Key dialog box to further adjust how your percussion tracks appear.
By manipulating the parameters in this dialog box, you can change the noteheads and articulation symbols used to display your percussion notes. You can also change the percussion sounds that correspond to the different positions on the percussion staff.

1. In the MIDI Note section, select the name of the instrument you want to change.
2. If you want to change the position on the percussion staff where that instrument will be shown, select the appropriate pitch in the Display As section. Then click the Bind button to assign that staff position to the selected instrument.
3. If you don’t want an instrument to have a specific staff position assignment, select the instrument and click either the Unbind button or the Default Note button. To remove all instrument assignments, click the Zap All button.

**Default Pitch Position** Any instruments that don’t have a specifically assigned staff position automatically use the default position, shown at the bottom of the Display As section. This means that those instruments are shown at that pitch position on the percussion staff. You can change the default position by typing in a new pitch value.

4. After you’ve bound an instrument to a position on the staff, you can designate the notehead type and articulation symbol it will use. Just select the appropriate options in those sections of the dialog box. When you set the notehead type, you can also opt to have the notehead circled by setting the Notehead Circled parameter.
5. If you want to use these settings again later, save them as a preset.
6. Click OK to close the Percussion Notation Key dialog box.
7. Click Close to close the Staff View Layout dialog box.

Now the data in your percussion tracks will be shown using the settings you specified.

**Ghost Strokes** SONAR displays *ghost strokes* (percussion notes played very softly for ornamentation) using the standard method of parentheses around the percussion notehead. It determines ghost strokes by testing to see whether the note velocity is lower than 32. This number is a fixed value that can’t be changed. You can change the note velocities of your data and then use the Velocity Trim track parameter to trick SONAR into using a different determining value. For example, to stop notes from being shown as ghost notes, simply raise their velocity values. Then, so the sound of the data isn’t changed, set the Velocity Trim parameter so that it lowers the velocities to their original values during playback. Do the opposite to have notes shown as ghost notes.
Showing Pedal Events and Chord Grids
You also can control whether or not the Staff view will display pedal events or guitar chord grids. To do so, in the Display section of the Staff View Layout dialog box, set the Show Pedal Events and Show Chord Grids options.

Changing Text Fonts
You can also change how any of the text used in your data will be displayed. For example, you can change track names, measure numbers, lyric text, expression text, chord text, triplet numbers, and tablature fret numbers by following these steps:

1. Right-click anywhere in the Staff pane and choose Layout to open the Staff View Layout dialog box.
2. In the Display section, choose the type of text you want to change by picking its designation from the Set Font list. For example, if you want to change how the track names look in your sheet music, select Track Names from the list.
3. Click the Set Font button to open the Font dialog box (see Figure 15.4).

   ![Font dialog box](image)

   **Figure 15.4** Using the Font dialog box, you can set how you want the text in your sheet music to appear.

4. In the Font section, choose the font you want to use.
5. In the Font Style section, choose a style for your text, such as Bold or Italic.
6. In the Size section, choose the size of the text you want to use. You can see your changes in the Sample section.

7. Click OK to close the Font dialog box.

8. Click Close to close the Staff View Layout dialog box.

Your text will be displayed according to the settings you specified.

Rhythmic Appearance
When converting your MIDI data into music notation, SONAR has to make some educated guesses about how to display the rhythmic values of the notes. It does so because when you record your musical performance in real time, instead of playing notes with perfect timing, you'll more than likely play some of them either a little ahead or a little behind the beat. You might also hold some notes a little longer than they should be held. Most often, these slight timing errors are desirable because they give your music a more human feel.

SONAR doesn't understand these slight rhythmic variations; it knows only exact note timing and duration. So when SONAR displays your data in the Staff view, the data might not always look like it should. That's why SONAR provides a number of parameters you can adjust to give it a better idea of how the music should be displayed.

Using Beam Rests
When you're notating music with very complex rhythms, it's standard practice to lengthen the beams on beamed groups of notes to also include rests. Lengthening the beams makes it much easier for the person reading the music to pick out the correct rhythms. For rhythmically simple music, it's usually best not to beam rests. If you need this feature, you can turn it on and off by opening the Staff View Layout dialog box and setting the Beam Rests option in the Display section.

Setting the Display Resolution
For SONAR to make an educated guess about how the rhythms in your music should be displayed, you have to give it a point of reference, which is called the display resolution. By setting this parameter, you are telling SONAR the smallest rhythmic note value used in your music. For example, if the smallest rhythmic value in your music is a sixteenth note, you would set a sixteenth-note value to be used for the display resolution. SONAR would then round any start times and note durations to the nearest sixteenth note so that your music would look more like it should. This setting changes only the appearance of the music, not how it sounds. To set the display resolution, select a rhythmic value from the Display Resolution list located in the toolbar (see Figure 15.5).

Filling and Trimming Durations
In addition to the Display Resolution parameter, SONAR provides two other options you can set to help it better understand how to display your music. The Fill Durations option rounds note
durations up to the next beat or note (whichever comes first). For example, instead of showing two quarter notes tied together in the same measure, SONAR simply shows a single half note.

The Trim Durations option rounds note durations down so that they do not overlap. For example, if you have a note with a duration that extends past the start of the next note, the first note’s duration will be shortened so that you don’t end up with something like a half note tied to a quarter note with an eighth note sitting between the two.

Neither of these options changes the music in any way—just how it’s displayed. The results will vary, depending on the music you are trying to display as notation, so you’ll have to try either or both of these options to see whether they help clean up the rhythmic notation values. To turn the options on or off, just click the Fill Durations and Trim Durations buttons (located to the immediate left of the Display Resolution parameter in the toolbar) or press F and M, respectively.

Dealing with Notes
As you know, when you open a MIDI track in the Staff view, the notes in that track are displayed in the Staff pane as standard music notation. In addition to simply displaying the notes, the Staff view edits and deletes them, as well as adding new ones.

You can add new notes to a track or edit the existing ones by using the Select, Draw, Erase, and Scrub tools.

Selecting
Press S to activate the Select tool. Using this tool, you can select the notes for further manipulation, such as deleting, copying, moving, and so on. Essentially, you select notes the same way you would in the Piano Roll view. To select a single note, click it. To select more than one note, hold down the Ctrl key while you click the notes you want to select.
Tied Notes  When you select a note that is tied to another note, both notes are selected automatically because they are essentially the same MIDI note with its duration shown as two tied notes rather than as one note with a larger rhythmic value.

Editing  
After you’ve made a selection, you can copy, cut, paste, move, and delete the notes the same way you would in the Piano Roll view. You can also edit notes individually using the Draw tool. Press D to activate the Draw tool. Using this tool, you can add and edit the notes in the Staff pane.

To move a note to a different location within a staff, simply click its notehead and drag it left or right. This action moves the note to a different horizontal location on the staff and along the Time Ruler. If you have the Snap To Grid feature activated, the note will snap to the nearest note value set in the Snap To Grid dialog box.

To change the pitch of a note, simply click its notehead and drag it up or down in the same staff or drag it into another staff. As you move the note, SONAR will play the different pitches so you can hear what they sound like.

Chromatic Note Changes  By default, SONAR uses note pitches that match the current diatonic key signature of the music. This means that as you drag a note to a new pitch, it automatically remains in the correct musical key. If you don’t want the note to stay within the key, press the right mouse button after you’ve begun to drag the note to a new pitch. This changes the pitch of the note chromatically in half steps.

Of course, sometimes you might want to make more precise changes to a note or change its duration. You can do so by using the Note Properties dialog box. Right-click a note to open the Note Properties dialog box (see Figure 15.6).

In the Note Properties dialog box, you can make precise changes to the time, pitch, velocity, duration, and MIDI channel of an individual note by typing in numerical values. You can also specify the fret and string upon which the note will be played in the Fretboard pane.

The Event Inspector  You can get quicker access to the properties of a note by using the Event Inspector toolbar. To activate it, choose Views > Toolbars. Put a check mark next to Event Inspector and click Close. Now whenever you use the Select tool to select a note in the Staff view, the note’s properties will be displayed in the Event Inspector toolbar. You can also change the note’s properties using the toolbar. Just click a property in the toolbar and either type in a new value or use the spin controls to increase or decrease the value. In addition, you can use modifiers (+/−) to change values relative to their current values. For
example, if you want to add 23 to a velocity value of 37, type +23 for the Vel parameter and SONAR will automatically change the value to 60. The plus and minus modifiers work for all parameters, but the Vel (velocity) and Dur (duration) parameters can also accept a percentage for scaling values. For example, with 100% representing the current value, if you want to lengthen a note by 20%, you would enter 120% for the Dur value. If you wanted to shorten the same note by 20%, you would enter 80% for the Dur value.

Figure 15.6 Using the Note Properties dialog box, you can make precise changes to a note in the Staff view.

**Drawing (or Adding)**

In addition to editing, the Draw tool enables you to add notes to a staff by literally drawing them. To do so, follow these steps:

1. Select the Draw tool by clicking its toolbar button or by pressing D.
2. Select a duration for the new note(s). If you look at the right half of the toolbar, you’ll notice a number of buttons with note values shown on them. Clicking these buttons determines the duration for your new notes. For example, if you click the Quarter Note button, the duration will be set to a quarter note. There are two additional buttons—one representing a dotted note and another representing a triplet. If you want your notes to be dotted or part of a triplet, click one of these buttons.

**Quick Duration Selection** To quickly choose duration values, use your computer keyboard. Press 1 for a whole note, 2 for a half note, 4 for a quarter note, 8 for an eighth note, 6 for a sixteenth note, 3 for a thirty-second note, . (period) for a dotted, and P for a triplet.
Triplet Quirks  When you create a triplet, SONAR places all three notes on the staff with the same pitch. Triplets have to be created with a full set of three notes without rests or ties. After you add the triplet, you can change the pitches of the notes to whatever you desire.

3. Click anywhere on a staff in the Staff pane to place the new notes at the start times and pitches you want.

Disable Fill and Trim  It’s a good idea to turn off the Fill Durations and Trim Durations options when you’re entering new notes in the Staff pane. When you add notes, SONAR will try to change the way they are displayed, and you might find this confusing when you’re trying to read the music.

Erasing  
Even though you can select and delete notes as described earlier, the Staff view includes an Erase tool for added convenience. To use it, press E and click any notes in the Staff pane that you want to delete. You can also click and drag the Erase tool over a number of notes to erase them all at once.

Scrub and Step Play  
When you’re editing the data in a track, the procedure usually involves making your edits and then playing back the project to hear how the changes sound. But playing back very small sections can be a bit difficult, especially when you’re working with a fast tempo. To remedy this situation, you can use the Scrub tool and the Step Play feature in the Staff view.

Scrub  
Using the Scrub tool, you can drag over the notes in the Staff view to hear what they sound like. To use it, press B; then click and drag over the notes in the Staff pane. Dragging left to right plays the data forward (what would normally happen during playback), and dragging right to left enables you to hear the data played in reverse. This feature can be useful for testing very short (one or two measure) sections.

Step Play  
The Step Play feature steps through (plays) the notes in the Staff view note by note. To use it, follow these steps:

1. Set the Now time to the point in the music where you want to begin stepping through the notes. You can do so by simply clicking the Time Ruler.
2. To step forward through the notes, press Ctrl plus the right arrow key.
3. To step backward through the notes, press Ctrl plus the left arrow key.
SONAR will move the Now time cursor one set of notes at a time, either to the right or left, and play the notes on which it lands.

Use Loopying for Editing Instead of using the Scrub tool or the Step Play feature, you might want to try another useful technique for hearing what your changes sound like. Did you know that you could edit the data in your project as it’s being played back? Of course, it’s a bit difficult to edit anything while SONAR is scrolling the display as the project plays. What I like to do is work on a small section of a project. I set up a section of the project to loop over and over, and as SONAR is playing the data, I make any changes I think might be needed. Because the data is being played back while I edit, I can instantly hear what the changes sound like. Using this approach is much easier than going back and forth, making changes, and manually starting and stopping playback. I described looping in Chapter 6.

Dealing with Symbols and Lyrics

In addition to notes, SONAR lets you add other markings to your notated music, including chord symbols, guitar chord grids, expression marks, and pedal marks. These markings are ornamental in nature; they have nothing to do with the data in your MIDI tracks. They also do not affect your music in any way (although there is one exception, which I’ll explain later).

Essentially, SONAR provides these features so you can create sheet music with a more professional look, but you have to enter the marks manually. The procedures are basically the same as when you’re working with notes. You use the Draw tool to add the markings, and you can select, copy, cut, paste, delete, and move them. To give you an idea of how to utilize the markings, I’ll go through them one at a time.

Chord Symbols and Grids

Most sheet music sold to the public includes chord symbols with simple chord names or with both names and guitar grids. SONAR gives you the flexibility to enter one or both.

Adding and Editing

To add a chord symbol to your music, follow these steps:

1. Select the Draw tool by pressing D.
2. Select the Chord tool by pressing C.
3. Position your mouse pointer above the staff to which you want to add the symbol.

Chord Symbol Positioning You can add chord symbols only in certain positions in your music. If a track is displayed as a single staff, you can place symbols above that staff.
If a track is shown using a pair of staves (treble and bass clefs), you can place symbols above the top (treble clef) staff only.

Also, chord symbols in music are usually lined up with the notes in the staff. SONAR places chord symbols in the same horizontal location above a note, only along the staff (although there is an exception, which I'll explain later). As you move your mouse pointer along the top of the staff, the pointer changes to look like a pencil when you find a "legal" position to place a chord symbol.

4. Click to place the symbol above the staff. SONAR will add a copy of the most recently added chord (the default is C).

5. To change the name of the chord symbol, right-click it to open the Chord Properties dialog box (see Figure 15.7).

6. Select the types of chords from which you want to choose by selecting a group from the Group list. SONAR includes only a single group of chords, called Guitar. You can, however, create your own groups and chord symbols.

7. For the Name parameter, select a new name from the list. You'll notice that multiple chords in the list have the same name. They're named the same because some chords
have guitar chord grids associated with them and some don’t. If a chord includes a grid, the grid is shown in the Grid section of the dialog box. You’ll also find multiple chords with grids that have the same name. This is to accommodate the different fingerings that you can use to play each chord on a guitar.

Quick Chord Selection  The list of chords is very long, and it can be tedious to scroll through it all just to find the chord you want. For a quicker way to navigate through the list, type the name of the chord you want to find in the Name field. Then press the up or down arrow key (depending on which way you want to move through the list).

8. Earlier I mentioned that SONAR places chords only at certain horizontal locations along the top of a staff. Although this is true when you are initially adding a chord, you can change the position of the chord by changing its start time. Just enter a new time (in measures, beats, and ticks) in the Time field of the Chord Properties dialog box. This way, you can place chord symbols anywhere along the top of a staff—they don’t have to line up with the notes.

9. Click OK.

SONAR will change the name and position of the chord symbol and add a grid to it, according to the new properties you specified.

The Chord Library
SONAR includes a large number of predefined chord symbols, which it stores as a Chord Library in a file named CHORDS.LIW. You can edit these chords or add your own by using the Chord Properties dialog box.

To add a chord into a new or existing group, follow these steps:

1. Right-click a chord symbol to open the Chord Properties dialog box.

2. To add a chord to an existing group, select the group from the Group list. To add a chord to a new group, type the name of the new group in the Group field.

3. Type the name of the new chord in the Name field.

4. To add a grid to the new chord, click the New Grid button. An empty grid will be displayed in the Grid area (see Figure 15.8).

5. To place a dot on the grid, first choose a finger number from the Finger options and then click the appropriate string and fret location on the grid. To assign an open string, select O for the finger number. To assign a muted string, select X for the finger number.
To insert a fret designation for the grid, click just to the right of the grid in the Grid section to open the Chord Fret Number dialog box. Then type a fret number and click OK.

6. To hear what the chord sounds like, click the Play button.

7. When you're satisfied with the new chord, click the Save button to save it to the Chord Library.

8. Click OK.

To edit a chord or group in the Chord Library, follow these steps:

1. Right-click a chord symbol to open the Chord Properties dialog box.
2. To delete a group, select it from the Group list and click the Delete button.
3. To edit a chord in an existing group, select the group from the Group list.
4. To delete a chord, select the chord from the Name list and click the Delete button.
5. To edit a chord, select the chord from the Name list and type a new name.
6. If the chord has an accompanying chord grid, you can either delete it or edit it. To delete it, click the Remove Grid button.
7. To edit the grid, change the finger assignment for a dot by clicking the dot repeatedly to cycle through the finger options.
8. To hear what the chord sounds like, click the Play button.

9. When you’re satisfied with the edited chord, click the Save button to save it to the Chord Library.

10. Click OK.

**Importing Chord Definitions** You can also import new chord definitions into the Chord Library by clicking the Import button and selecting an .LIW file.

### Expression Marks

Expression marks in music designate any kind of text that provides instructions on how the music should be played during different passages. These marks include tempo designations (such as allegro), musical characteristics (such as play with feeling), and dynamics instructions (such as cresc., ppp, or fff). Essentially, expression marks are just simple text added to the sheet music.

**Adding an Expression Mark**

To add an expression mark to your music, follow these steps:

1. Select the Draw tool by pressing D.
2. Select the Expression tool by pressing I.
3. Position your mouse pointer below the staff to which you want to add the mark.

**Expression Marks Positioning** As with chord symbols, you can place expression marks only at certain positions in your music. If a track is displayed as a single staff, you can place a mark below that staff. If a track is shown using a pair of staves (treble and bass clefs), you can place marks below the top (treble clef) staff only.

Also, as with chord symbols, marks are initially lined up with the notes in the staff (although you can change the way they’re lined up by editing the marks and altering their start times). As you move your mouse pointer below the staff, the pointer will change to look like a pencil when you find a “legal” position to place a mark.

4. Click to place the mark below the staff. SONAR will open an insertion box.
5. Type the text you want to use for the mark (see Figure 15.9).
Dangling Hyphens  To leave a dangling hyphen at the end of an expression mark, type a space and a single hyphen after the text in the insertion box. Dangling hyphens are often used with expression marks in sheet music to show that the expression should be continued over a range of notes or measures until the next expression mark appears.

6. Press the Enter key.

Use Tab to Move  You can also press the Tab or Shift+Tab keys to move to the next or previous expression mark location, respectively.

SONAR will add the expression mark to your music.

Editing an Expression Mark
To edit an expression mark, follow these steps:

1. Right-click the expression mark to open the Expression Text Properties dialog box (see Figure 15.10).

![Figure 15.9  Expression marks are just simple text that you type into the Staff pane.](image)

![Figure 15.10  Using the Expression Text Properties dialog box, you can edit expression marks.](image)
2. To change the position of the expression mark, enter a new start time (in measures, beats, and ticks) in the Time field.

3. To change the text of the expression mark, enter the new text in the Text field.

4. Click OK.

The expression mark will be displayed in the new position and will show the new text according to your settings.

---

**Edit with the Draw Tool** You can also edit the text of an expression mark by clicking it with the Draw tool to reopen the insertion box.

---

**Hairpin Symbols**

In addition to showing crescendos and decrescendos as text via expression marks, you can show them graphically via hairpin symbols. These symbols look like large greater than and less than signs (see Figure 15.11).

![Figure 15.11](image)

**Figure 15.11** You can designate crescendos and decrescendos via hairpin symbols.

---

**Adding a Hairpin Symbol**

To add a hairpin symbol to your music, follow these steps:

1. Select the Draw tool by pressing D.

2. Select the Hairpin tool by pressing H.

3. Position your mouse pointer below the staff to which you want to add the symbol.
Symbol Placement As with expression marks, if a track is displayed as a single staff, you can place the symbol below that staff. If a track is shown using a pair of staves (treble and bass clefs), you can place the symbol below the top (treble clef) staff only.

4. Click to place the symbol below the staff.

SONAR will add a copy of the most recently added hairpin symbol. To change the symbol, you can edit it by using the Hairpin Properties dialog box.

**Editing a Hairpin Symbol**

To edit a hairpin symbol, follow these steps:

1. Right-click the hairpin symbol to open the Hairpin Properties dialog box (see Figure 15.12).

![Hairpin Properties dialog box](image)

**Figure 15.12** Using the Hairpin Properties dialog box, you can edit hairpin symbols.

2. To change the position of the hairpin symbol, enter a new start time (in measures, beats, and ticks) in the Time field.

**Drag to a New Position** You can also change the position of the hairpin symbol by dragging it.

3. To change the type of the hairpin symbol, choose either the Crescendo option or the Diminuendo (same as decrescendo) option.

4. To change the length of the hairpin symbol, enter a new value (in beats and ticks) in the Duration field.

5. Click OK.
The hairpin symbol will be displayed in the new position with the new type and duration, according to your settings.

**Pedal Marks**

Earlier, I mentioned that there was one exception to the rule that markings do not affect the data in your MIDI tracks; that exception is pedal marks. On a sheet of music, pedal marks usually designate when the performer is supposed to press and release the sustain pedal on a piano. In SONAR, they mean essentially the same thing, but they refer to the sustain pedal attached to your MIDI keyboard (if it has one). More precisely, pedal marks in the Staff view designate MIDI controller number 64 (pedal-sustain) messages in your MIDI tracks (which you can also edit in the Controller pane of the Piano Roll view). So whenever you add or edit pedal marks in the Staff view, you are also editing the MIDI controller number 64 messages in that track.

**Adding a Pedal Mark**

To add a pedal mark to your music, follow these steps:

1. Select the Draw tool by pressing D.
2. Select the Pedal tool by pressing A.
3. Position your mouse pointer below the staff to which you want to add the mark.
4. Click to place the mark below the staff.

SONAR will add a pair of pedal marks (pedal down, which looks like an asterisk, and pedal up, which looks like a P) to your music. To edit the marks, you can use the Pedal Properties dialog box.

**Editing a Pedal Mark**

To edit a pedal mark, follow these steps:

1. Right-click the pedal mark (either a pedal down mark or a pedal up mark; you can’t edit them both at once) to open the Pedal Properties dialog box (see Figure 15.13).
2. To change the position of the pedal mark, enter a new start time (in measures, beats, and ticks) in the Time field.
620  SONAR 8 Power!: The Comprehensive Guide

3. To change the MIDI channel for the pedal mark, type a new channel number in the Channel field.

4. To change the type of pedal mark, enter a new number in the Value field. Enter 0 to make it a pedal up mark; enter 127 to make it a pedal down mark. Entering any number between that range produces no effect.

5. Click OK.

The pedal mark will be displayed in the new position with the new type and MIDI channel according to your settings.

Lyrics
Just like any good notation software, SONAR enables you to add lyrics to your sheet music. Lyrics (like expression marks) are represented by simple text displayed below a staff. You can add lyrics to a track by using the Lyrics tool or the Lyrics view.

The Lyrics Tool
Follow these steps to add lyrics to your music using the Lyrics tool:

1. In the Staff view, select the Draw tool by pressing D.

2. Select the Lyrics tool by pressing Y.

3. Position your mouse pointer below the staff, underneath the first note to which you want to add lyrics.
Lyric Placement  If a track is displayed as a single staff, you can place the lyrics below that staff. If a track is shown using a pair of staves (treble and bass clefs), you can place lyrics below the top (treble clef) staff only.

Also, each word or syllable in the lyrics must be aligned with a note. SONAR automatically aligns the lyrics to the notes in the staff.

4. Click to place the lyric below the staff. SONAR will open an insertion box, just like when you add expression marks.
5. Type a word or syllable to be aligned with the current note.
6. To move forward and add a lyric to the next note, enter a space, type a hyphen, or press the Tab key. The insertion box will move to the next note and wait for you to enter text.
7. To skip over a note, don’t type any text in the insertion box. Enter a space or type a hyphen.
8. To move back to the previous note, press the Shift+Tab keys.
9. When you’re finished entering lyrics, press the Enter key.

To edit lyrics using the Lyrics tool, follow these steps:

1. Select the Draw tool.
2. Select the Lyrics tool.
3. Click the word you want to change.
4. Edit the word.
5. Press the Enter key.

The Lyrics View
After you’ve entered some lyrics in the Staff view, you can display them in a separate window called the Lyrics view. This view is useful for providing a cue for performers who are recording vocal tracks because you can make the lyrics appear in any size font you like (see Figure 15.14).

To open the Lyrics view, select a track in the Track view and then choose Views > Lyrics. To change the size of the text, click the fs or fb button, which provide two different preset font sizes. You can use more specific font settings by clicking the Font button to open the Font dialog box. In this dialog box, you can change the font, style, and size of the text. The Lyrics view also has a Pick Tracks button that works just as in the other views.

You can also add and edit lyrics in the Lyrics view, but I wouldn’t recommend it. The process is not very intuitive because you can’t see the notes to which the words and syllables are being
aligned. If you want to use the Lyrics view for adding and editing, you can do so just as you would enter and edit text in Windows Notepad. Each word you type is aligned automatically to a note in the current track.

**Copy and Paste Lyrics** In addition to typing and editing lyrics in the Lyrics view, you can also select, cut, copy, paste, and delete text. Again, this procedure works just like in Windows Notepad with a right-click of your mouse. What’s nice about the Lyrics view is that if you already have some text saved in a text file, you can copy and paste it into this view to add lyrics quickly to a track. When you look at the lyrics in the Staff view, the words are aligned automatically to the notes in the staff.

---

**The Fretboard and Tablature**

For all the guitar players out there, SONAR provides a couple of nice notation-related features just for you. The first one I’ll describe is the Fretboard pane.

**The Fretboard Pane**

The Fretboard pane, located at the bottom of the Staff view, is both a visual aid and an editing tool. During playback, the Fretboard displays the notes at the current Now time in a selected track as they would be played on a six-string guitar using standard tuning. This makes the Fretboard a cool learning tool when you’re trying to learn to play a new piece of music. It also
displays notes when you use the Scrub tool or Step Play feature, which makes it even easier to pick out the fingerings. The color of the notes matches the color of the clip (from the Track view) in which they are stored.

**Fretboard Properties**

You can configure certain aspects of the Fretboard, such as its background style and the orientation of the strings. You can also turn it on or off. To toggle the Fretboard on and off, press the V key.

To change the background style, right-click the Fretboard and choose Wood Grain and one of the following from the list: Rosewood Hi, Rosewood Lo, Ebony Hi, Ebony Lo, Maple Hi, or Maple Lo. The Hi and Lo designations deal with the screen resolution you are using on your computer monitor. If you’re using a high screen resolution, use one of the styles marked Hi. If you’re using a low screen resolution, use one of the styles marked Lo. To be honest, the resolution you choose really doesn’t make that much of a difference.

To change the orientation of the strings, right-click the Fretboard and select Mirror Fretboard to invert the Fretboard so that the highest-sounding string appears at the bottom. To change it back, just select Mirror Fretboard again.

**Adding Notes**

In addition to using the Fretboard to display notes, you can add new notes to a track (staff) by clicking the Fretboard. Just follow these steps:

1. Set the Now time so that the cursor rests at the point in the staff where you want to add the note(s). You can do so by clicking in the Time Ruler.
2. Select the Draw tool by pressing D.
3. Select a note duration by clicking one of the duration toolbar buttons.
4. Click the guitar strings in the Fretboard to enter notes on the staff. You can enter up to six notes (one per string).
5. Make the Now Time cursor move forward by the same amount as the current note duration setting by pressing the Shift and right arrow keys.
6. Repeat Steps 3 through 5 to continue adding more notes.

**Editing Notes**

You can also edit existing notes in a track (staff) by using the Fretboard. You can change only the pitch of the notes, though. To do so, just follow these steps:

1. Set the Now time so the cursor rests on top of the note(s) that you want to edit. You can do so by clicking the Time Ruler. You can also use the Step Play feature.
2. Select the Draw tool by pressing D.
3. Drag the notes along the strings to a new fret (thus changing the pitch).

After you release the mouse button, SONAR will change the pitch of the notes in the staff.

**Tablature**
As a guitar or bass player, you might be more comfortable reading and working with tablature than standard notation. If that’s the case, you’re in luck because SONAR includes a number of features that display and edit your music as tablature.

**Displaying Tablature**
To display tablature for a track (staff), follow these steps:

1. Right-click in the Staff pane and select Layout to open the Staff View Layout dialog box.
2. Select from the list the name of the track for which you want to display tablature.
3. In the Tablature section, activate the Display Tablature option.
4. Select a tablature style from the Preset list.
5. Click OK.

SONAR will display a tablature staff below the current staff, complete with tablature for each note in the track (see Figure 15.15).

**The QuickTab Feature** SONAR also offers a feature called QuickTab that lets you quickly generate tablature for a track, but it works only when you’re displaying a single track in the Staff view. I recommend you use the previously mentioned method.
Defining a Tablature Style

When you’re setting up a track to display tablature, you might not find a preset style that fits your needs. If that’s the case, you can always create your own tablature style by following these steps:

1. Right-click the Staff pane and select Layout to open the Staff View Layout dialog box.
2. Select from the list the name of the track for which you want to display tablature.
3. In the Tablature section, activate the Display Tablature option.
4. Click the Define button to open the Tablature Settings dialog box (see Figure 15.16).

5. Under the Tablature tab, set the Method parameter. This parameter determines how the tablature will be displayed. If you select Floating, the notes can be shown anywhere on the Fretboard. If you select Fixed, notes are limited to a specific area on the neck.
of the guitar. To determine the size and position of that area, you must set the Finger Span and Lowest Fret parameters. The Finger Span parameter sets the size of the area in a number of frets. The Lowest Fret parameter sets the position of the area on the neck of the guitar by specifying the first fret upon which the area is based. The last tablature method (MIDI Channel) is useful if you record your guitar parts using a MIDI guitar and you use MONO mode so that each string is recorded using its own MIDI channel. If this is your situation, then select the MIDI Channel method and set the 1st Channel parameter to the lowest number channel used by your MIDI guitar.

6. In the Number of Frets field, enter the number of frets on which the tablature should be based.

7. In the String Tuning section, choose an instrument/tuning upon which to base the tablature.

8. Set the Number of Strings parameter to the number of strings the instrument provides.

9. The pitches of each string for the instrument appear in the parameters below the Number of Strings field. You can either leave them as is, or you can customize the pitches to your liking.

10. Save your settings as a preset.

11. Click OK to close the Tablature Settings dialog box.

Your new tablature style should appear in the Preset list in the Tablature section of the Staff View Layout dialog box.

**Regenerating Tablature**

You can use different tablature styles for different sections of the same tablature staff by following these steps:

1. In the Staff pane, select the notes or tablature numbers for which you want to use a different tablature style.

2. Right-click anywhere in the Staff pane and select Regenerate Tablature to open the Regenerate Tablature dialog box (see Figure 15.17).

3. Set the Method, Finger Span, Lowest Fret, and 1st Channel parameters, if applicable. These parameters work the same way as described previously.

4. Click OK.

SONAR will change the tablature style of the selected notes based on your parameter settings.
Adding Notes via Tablature

In addition to displaying tablature, you can use a tablature staff to add notes to a track by following these steps:

1. Select the Draw tool by pressing D.
2. Choose a note duration by clicking one of the duration toolbar buttons.
3. Move the mouse pointer over the tablature staff. It will change its shape to a crosshair.
4. Position the crosshair within any measure and over a line in the tablature staff.
5. Click and hold the left mouse button and then drag your mouse pointer up and down to select a fret number.
6. Release the mouse button to enter the note.

Editing Notes via Tablature

You can also edit notes via a tablature staff. To do so, just follow these steps:

1. Select the Draw tool by pressing D.
2. To change the fret number of a note, right-click it and select a new number.

Figure 15.17  You can define different tablature styles for selected notes by using the Regenerate Tablature feature.
3. To move a note to a different string (line) on the tablature staff, click and drag the note while pressing the Alt key. Drag the note up or down to move it. If the note is not supposed to play on a certain string, it will not be allowed to move there.

**Exporting Tablature to a Text File**

One last tablature feature that you might find useful is being able to save the tablature as a text file either for printing or distribution over the Internet. By saving the tablature this way, you can share it with other guitarists—even if they don’t own SONAR. You use this feature as follows:

1. Select a MIDI track in the Track view.
2. In the Staff view, right-click anywhere in the Staff pane and select Export to ASCII TAB. The Save As dialog box will open.
3. Type a name for the file.
4. Click Save.

SONAR will save the data in the MIDI track as tablature in a text file.

---

**Quantize for Accuracy** You might want to try quantizing the track before you save it as tablature. Doing so usually produces more accurate results.

---

**Printing Your Music**

After all is notated and done, you can print your music to paper if you have a printer connected to your computer. SONAR automatically sets up your music on separate pages, including the song title, composer, and other information, along with the notation. You can print your musical score by following these steps:

1. Choose File > Info to open the File Info window and then fill out all the information you want to include on your sheet music. You can use the Title, Subtitle, Instructions, Author, and Copyright parameters. For more information about the File Info window, refer to Chapter 4.
2. With the Staff view open, choose File > Print Preview. SONAR will go into Print Preview mode (see Figure 15.18) and display your music on virtual pages, letting you see how it will look before you print it.
3. To zoom the display in or out, click the Zoom In or Zoom Out button.
4. Depending on the length of your song, SONAR usually shows two pages at once on the screen. If you would rather view only one page at a time, click the One Page button.
5. If your song takes up more than two pages, you can navigate through them by using the Next Page and Prev Page buttons.

6. Before you print your music, you need to select a size for your score. To do so, click the Configure button to open the Staff View Print Configure dialog box.

7. From the single list, choose the size you want to use. SONAR provides nine different standard music-engraving sizes used by professional music publishers. Each size is used for a different purpose. Size 0 (Commercial or Public) is used typically for wire-bound
manuscripts. Size 1 (Giant or English) is typically used for school band music books or instructional books. Sizes 2 and 3 (Regular, Common, or Ordinary) are typically used for printing classical music. Size 4 (Peter) is typically used for folios or organ music. Size 5 (Large Middle) is typically used for ensemble music. Size 6 (Small Middle) is typically used for condensed sheet music. Size 7 (Cadenza) is typically used for pocket music editions. And Size 8 (Pearl) is typically used for thematic advertisement.

8. Click OK. The music will be redrawn using the new size.
9. Click the Print button.

When the standard Windows Print dialog box opens, you can set up your printer and print your music.

Composing with the Staff View  Here’s one final tip: If you like to compose your music from scratch using the Staff view, you can use one of the included templates listed in the New Project File dialog box when you create your new project. For example, if you want to compose for a string quartet, select the Classical String Quartet template.

The templates come with all the track parameters preset, but you might need to change a few of them to match your studio setup. After that, select all the tracks in the Track view and then choose Views > Staff to open them in the Staff view. Everything will be set up with the proper clefs, staff names, and more; the only settings you might need to adjust are the meter and key. Other than that, you will have a blank slate ready and waiting to be filled with the music notation for your latest masterpiece.